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assumes no liability of any kind, including the implied warranties of non- infringement, merchantability
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AMD's Standard Terms and Conditions of Sale.
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OVERVIEW

OVERVIEW

Radeon™ ProRender is a free un-biased rendering add-in for your design and
manufacturing needs in Dassault Systémes SOLIDWORKS®. Using physically
accurate path-tracing technology, Radeon ProRender can produce stunning
photorealistic images of your model and provides real-time interactive rendering
and continuous effects adjustments to help create the perfect rendered image.
Radeon ProRender supports real-time updates for changes that to the parts and
assemblies within SOLIDWORKS, offering a continuous render preview.

This user manual will describe how to setup Radeon ProRender for SOLIDWORKS
and how to use it from adding decals through to the final save of the rendered
image. This guide will also explain the additional features such as post render image
adjustments, decal placement, generating rendered animation files from
SOLIDWORKS motion studies, and how to incorporate Radeon ProRender into your
design workflow.
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WHAT'S NEW 2
What's New

e Physically based sun and sky — set a time and day and place and get the accurate background and
lighting from the sky, or interactively set the sun angle and color.

Turbity —

Disc Size -

Time of Day —

e Raytracing performance is significantly improved in most scenes for AMD GPU hardware.

¢ You can now render volumes with cameras inside the volume.
e Files can be exported for interchanging between plug-ins.
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SUPPORTED PLATFORMS 3

Supported Platforms

Radeon ProRender runs on both GPUs and CPUS. OpenCL™ 1.2 is required for GPUs.

Software

e Dassault Systémes SOLIDWORKS® 2016 or higher

Operating System

e Microsoft Windows® 7 (64-bit)
e Microsoft Windows® 8.1 (64-bit)
e Microsoft Windows® 10 (64-bit)

Hardware Compatibility
Radeon ProRender for SOLIDWORKS is compatible with the professional graphics products.

Microsoft Microsoft Microsoft

Windows 7 (64-bit) = Windows 8.1 (64-bit) Windows 10 (64-bit)

Radeon™ WX Series v v
Radeon™ Vega Frontier Edition v v
Radeon™ Pro SSG v
Radeon™ Pro Duo (“Polaris”) v v
AMD FirePro™W Series v v
Radeon™ Pro Duo ("Fiji") v v v
Radeon™R9 Series v v v
Radeon™ RX Series v v v
Non-AMU GPU v
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INSTALL RADEON PRORENDER

Install Radeon ProRender add-in

Download the Radeon ProRender add-in for SOLIDWORKS and launch the setup, agreeing to the license.

‘ﬁ Radeon ProRender for SOLIDWORKS ® Setup — >

Welcome to the Radeon ProRender for
SOLIDWORKS® v0.9.196.37 Setup
Wizard

The Setup Wizard will install Radeon ProRender for
SOLIDWORKS® on your computer. Click Next to continue or
Cancel to exit the Setup Wizard,

Home Page, Benefits Features, and Reguirements

RADEON

Cancel

ﬂ Radeon ProRender for SOLIDWORKS® Setup -

End-User License Agreement

Please read the following license agreement carefully

RADEON

X

ADVANCED MICRO DEVICES, INC.
END USER LICENSE AGREEMENT
{ProRender Plug-In)

IMPORTANT-READ CAREFULLY: DO NOT INSTALL, COPY OR USE
THE ENCLOSED SOFTWARE, DOCUMENTATION (AS DEFINED
BELOW), OR ANY PORTION THEREOF, (COLLECTIVELY
"SOFTWARE") UNTIL YOU HAVE CAREFULLY READ AND AGREED TO
THE FOLLOWING TERMS AND CONDITIONS. THIS IS A LEGAL
AGREEMENT ("AGREEMENT") BETWEEN YOU (EITHER AN
INDIVIDUAL OR AN ENTITY) ("YOU") AND ADVANCED MICRO
DEVICES, INC. ("AMD").

I accept the terms in the License Agreement

Print Back

Cancel

Radeon ProRender will check your hardware and software to ensure requirements and you can then

choose where to install the add-in.

‘ﬁ Radeon ProRender for SOLIDWORKS ® Setup * ﬁ] Radeon ProRender for SOLIDWORKS ® Setup — X
Check hardware Custom Setu
RADEON P RADEON
Check hardware and software... [ — Select the way you want features to be installed. [ —
Click the icons in the tree below to change the way features will be installed.
Hardware check: 0K
Gatinackhede £3 Radeon ProRender for
SOLIDWORKS &
This feature requires 10MB on your
hard drive.
Location: C:¥Program Browse...
Files\AMD\RadeonProRenderPlugins\SOLIDWORKS Y,
Back Next Cancel Reset Disk Usage Back Cancel
—

Radeon ProRender add-in for SOLIDWORKS User Guide
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INSTALL RADEON PRORENDER | 5

Install the Radeon ProRender Add-In. Then, click on Register... to get your activation key.

ﬁ Radeon ProRender for SOLIDWORKS® Setup = X ﬂ Radeon ProRender for SOLIDWORKS® X

Plugin activation
Ready to install Radeon ProRender for SOLIDWORK£ ADEON o RADEON

Please register and you will receive your activation key.

Click Install to begin the installation. Click Back to review or change any of your

installation settings. Click Cancel to exit the wizard.

Activation key:

l

Back ‘m Cancel Next Cancel

Register using your information. You will receive your activation key after clicking Request Download.
Enter it into the installer and continue the installation.

AMD Developer: Radeor X

& C | @ www.amdsurveys.com/se/5ATE27D2580

AMDA1

Thank you for downloading the Radeon ProRender Add-in for Dassault Systémes SOLIDWORKS®. Please
provide the information requested below to download the add-in.

Contact Information
First Name

AMD

Last Name

ProRender

Email Address

design@amd.com

Country

CANADA v

Please provide a brief description of the product or project where Radeon ProRender will be used

Want fast photo-realistic render of my design |

Stay up to date and informed about the latest tools, events and resources for AMD software technology.
Subscribe to the AMD Developer newsletter and join thousands who are already enjoying this resource
created for developers by developers.

Yes, | would like to receive the Developer newsletter and related AMD Developer Central communications.

Request Download

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



Radeon ProRender Setup

Launch SOLIDWORKS 2016 or higher. Go to Tools > Add Ins... to enable the Radeon ProRender add-in.

RADEON PRORENDER SETUP

JESSDLIDWORKS File  Wiew | Tools

Help j‘l B'E?'

Verify that the Radeon ProRender line has both the active and start-up checkboxes checked.

SOLIDWORKS Applications

Kpress Products

Add-Ins...

SOLIDWORKS PO
Radeon ProRender
Design Checker

Compare

{@} Options...

Add-Ins

*

Active Add-ins

Last Load

| Start Up Time

[=] SOLIDWORKS Premium Add-ins

|

|

[ Cireuitworks

Dg FeatureWaorks

1€ Phatoview 360

D% ScanTo3D

DQI: SOLIDWOREKS Design Checker
D SOLIDWORKS Motion

(&) SOLIDWORKS PDM Client
Dﬁg SOLIDWORKS Routing

O @ SOLIDWORKS Simulation

|:| ? SOLIDWORKS Toolbox Library

SOLIDWORKS Toolbox Utilities

O%f soupworks utilities

SOLIDWORKS Workgroup PDM 2017

|:| EI TolAnalyst

[=] SOLIDWORKS Add-ins

od

385

= 1s

= 1s

OooodooooroOOoo

O
O

|

Autotrace
SOLIDWORKS Composer
SOLIDWORKS Flow Simulation 2017

I SOLIDWORKS Forum 2017

SOLIDWORKS PCB 2017

[= Other Add-ins

ORO”O

|
|

Radeon ProRender
SOLIDWORKS 3DEXPERIENCE SmartLink
SOLIDWORKS ¥PS Driver 2017

| ok || ca

OOr

necel
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RADEON PRORENDER START UP

Radeon ProRender Start Up

Go toFile > Open... to import a model OR, go to File > New to start a new part or assembly.

JP?SSGLIDWDRKS File | Wiew Towols Help » | D = Ef? =
il
B}" Open... Ctrl+0

Locate the top toolbar in the main SOLIDWORKS interface. If there is no Radeon ProRender tab, right-
click any of the tabs (Assembly, Layout, Sketch...etc.) and enable the Radeon ProRender tab.

2 _ _ . .
_]PSSGLIEWGRKS File Edit View Insert Tools Window Help _fl D *B}*

G [ ) & il S ¥ I

CircuitWorks PhotoView ScanTo3D SOLIDWORKS SOLIDWORKS SOLIDWORKS SOLIDWORKS  TolAnalyst S0
360 Motion Routing Simulation Toolbox

i

Assembly | Layout | Sketch | Evaluate | SOLIDWOFFE= """
¥ | Assembly

Layout
Sketch

LY Y

Evaluate

Render Tools

[..medd-'m

Radeon ProRender

v | Use Large buttons with [ext

Customize CommandManager...

The Radeon ProRender tab should include the following buttons.

J;??SSDLIDWDEKS File Edit View Inset Tools Window Help »

B © W @

Rendering Properties Animation About
Window Page Dialog Dialog

Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Radeon ProRender |

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



RADEON PRORENDER START UP | 8

Rendering Window Overview

Rendering
Window

In the Rendering Window, you can:

e view the number of renderingiterations for the current frame

e apply post effects

e applydecals

e change settings

e pause/continue/restart the render process

e savetheimage

e synchronize the render with changes you have made in SOLIDWORKS (if it does not refresh automatically)

| File Window Help

AM D a Orbit Camera

Iterations: 94

Post Effects Decals Settings

+ Tone Mapping

Type

None

“ White Balance
Enabled

Color Temperature

Color Space

sRGB

¥ Gamma Correction

¥ Output Levels

Reset To Defaults

By default, the rendering window will show the same view as the current window in SOLIDWORKS. Any
changes that are made in SOLIDWORKS will be reflected in real-time in the Radeon ProRender window.
This window is where post editing effects are applied to the rendered image.

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



RADEON PRORENDER START UP | 9

”// Tip: The Radeon ProRender window floats above the SOLIDWORKS window, but you can place
A / the two windows side by side.

File Window Help

DDSSOLIDWORKS File Edit View Inset Tools Window Hep A | (- -F-S-9 .@. ('] [in s s m]

=] o @ 3 Orbit Camera
Rendering Properties About " Iterations: 596
Window  Page Dialog

PostEffects Decals  Settings
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Radeon ProRender |

Phca@ 0-Bog

= Tone Mapping
Type

None

“ White Balance

Enabled
Color Temperature
Color Space

sRGB

~ Gamma Correction

¥ Output Levels

L Model [ Motion Study 1| Reset To Defaults
ISOLIDWORKS Premium 2017 x64 Edition Fully Defined Process complete _Editing Assembly

|m o vl

11:28AM

(1] sy ANED s B
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RADEON PRORENDER START UP

Properties Page Overview

Properties
Page

The Properties Page is a standard SOLIDWORKS properties page and appears in the SOLIDWORKS

window. In the Properties Page, you can:

e adjust the output frame resolution and size

e select the render device(s)

e adjust when the rendered image is saved

e change the mesh quality and render quality

e adjust floor reflection/shadow settings

e enable debug options when working with AMD support

‘D’S SOLIDWORKS‘ File Edit View |Insert Tools Window Help » v é e D.. ? e () e
= @
Rendering About
Window Dialog
Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Radeon ProRender | e
— P @ ©-F =B
v@ M » & DSLR-350-SolidWorks200... @
Radeon ProRender Properties ®@ m
v x )
Resolution Setti W
esolution ngs O
Render Settings M
Render Completion Settings M Q
: )
Quality Settings v L
Floor Settings v
Debug v

W10 Model | Motion Study 1|

SOLIDWORKS Premium 2017 x64 Edition

Fully Defined Processing... Editing Assembly

Radeon ProRender add-in for SOLIDWORKS User Guide
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MODEL SETUP

Model Setup
Background Setup in SOLIDWORKS

In SOLIDWORKS, left-click the background and then right-click to display the options. Click Edit Scene.

/%SOLIDWORKS File Edit View Insert Tools Window Help » B '[27' Y g it ta '@' e D.. 7 v e =] ¢
B © B ©

Rendering Properties Animation About
Window Page Dialog Dialog

Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Radeon ProRender | O =

demenlep

e v #0a

,@ Zoom to Fit

6{:5 Zoom to Area
Ié) Zoom In/Out
@ Rotate View

C%b Pan
G Roll View

:l Rotate About Scene Floor

Open Drawing

% Temporary Fix/Group

Recent Commands >

¥

Y

e

W77 Model [ Motion Study1 |
Edit the scene applied to the document. Fully Defined  Editing Assembly MMGS  + &

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



The SOLIDWORKS view should now have a Edit Scene task bar on the left, and a display of various scenes
on theright.

MODEL SETUP

D’SSOLIDWORKS‘ File Edit View Inset Tools Window Help »

v 33 + DSIR-350-Soli... (D search sOLDWORKsHelp Q | 2 + — [ X

Rendering Animation About
Window Dialog Dialog

Background

Image v

‘ C:\Program Files\SOLIDWORKS C

Browse...

Stretch image to fit
SOLIDWORKS window

Keep background

Environment

‘ C:\Users\Annie\Desktop\Camera

Browse...

Floor
Floor reflections
Floor shadows
Flatten floor (Background
must be set to Use

Environment)

Align floor with:
| 2 |[Bottom View Plane A
Floor offset:

[A][omm 3

(RERENENNERRRRA

Offset to Geometry

Display States (linked)
(@) This display state
O All display states
O Specify display states

~

A~

v

Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Radeon ProRender = - «  Appearances, Scenes, and Decals -
- » @ DSLR-350-SolidWorks200... @® - a ¢
@ R &€ =~ o -
| ) Appearances(color,
Edit Scene @ ® _@. v & Scenes
v X _B_ @ Basic Scenes
Basic @ Studio Scenes
g @ Presentation Scenes
Message AN Eﬁ Backgrounds
Shadows in Shaded mode are currently Q > &3 Camera Model
ot 5 [E Decals

Drag and drop scenes anywhere into the
graphics view.

3 Point Beige

3 Point Blue

e ]

3 Point Faded

W77 Model [ Motion Study 1 |

SOLIDWORKS Premium 2017 x64 Edition

Fully Defined

Editing Assembly

= @

Alternatively, you can click on the coloured ball to display these built-in Appearances and Scenes.

Radeon ProRender add-in for SOLIDWORKS User Guide
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MODEL SETUP

For this guide, Presentation Scenes will be used, as they simulate a real-life background. Click on the
scene to apply or drag the file into the area surrounding the model.

“77S SOLIDWORKS‘ File Edit View Inset Tools Window Help » v v v g v v v {EJ:} v DSLR-350-Soli... @ Search SOLIDWORKS Help Q v " ¥ o EEX
= | I
=) - O
Rendering Animation About
Window Dialog Dialog
Assemb!y‘ Layout ‘ Sketch ‘ Evaluate] SOLI?WORKSAdd-Ins Radeon ProRender ;;;. }:3 /‘: @ 2 q:] - [~ i <«  Appearances, Scenes, and Decals
= — = » @DSLR-SSO-SoIidWorks200... @, - @ T
9 BR[o[€] - [ y—
| ppearances(color)
Edit Scene @& ® m % & St
v X ta Q Eﬁ Basic Scenes
E—— 4
Basic @ Studio Scenes
@ @ Presentation Scenes
Message 7al| ) @ Backgrounds
Shadows in Shaded mode are currently @ Q Camera Model
off. (" | Y [a Decals
Background ~
Image o Drag and drop scenes anywhere into the

graphics view.

[ C:\Program Files\SOLIDWORKS C

Browse...

Stretch image to fit
SOLIDWORKS window

Keep background

Environment Lo

‘ C:\Program Files\SOLIDWORKS (

Kitchen Background

Browse...

Floor Lo
DFIoor reflections
Floor shadows

Flatten floor (Background
must be set to Use
Environment)

Align floor with:

1) ‘ Bottom View Plane v

Floor offset:
[A] omm
RERNNNNNRNRARN}

Offset to Geometry

<

Factory Background

Display States (linked) A l % -
@This display state
OAII display states
O Specify display states - ‘
[WZIT] Model [ MotionStudy 1 | W

SOLIDWORKS Premium 2017 x64 Edition Fully Defined  Editing Assembly - &

These files are .hdr files which display more information and contain a higher range of intensities than a
regular image file, for example a .hdr file can contain fine grain detail in shadow areas inside an unlit room
and also the fine grain details of the scene outside that visible through the windows.

\/ Cool fact: Importing .hdr files will allow the surrounding scene to simulate ambient lighting and
contain more background details.

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



MODEL SETUP

You may notice that the background does not change, but the lighting on the model does. This is
because the lighting is determined by the Environment, whereas the Background is set independently.

@ BB o @]

Edit Scene @3‘; @®
v X
Message AN

Shadows in Shaded mode are currently off.

Image ~

Q | C\Program Files\SOLIDWORKS Corp\SOLIDWORKS \dat

Erowse..,

|:| Stretch image to fit SOLIDWORKS window
Keep background

Environment La

% | C:\Users\Annie\DesktopCamera ModeldDstudioLight

Browse...

The environment will determine the lighting, how it is reflected/refracted onto the surfaces of the model.
The background is simply the “wallpaper” that is laid behind the model. You can use the Environment as
the background image.

@ BR[| ¢S]

Edit Scene @f @
v X
Message ~ N

Shadows in Shaded mode are currently off.

Background L

Image w

Maone

@ Colar

Gradient

Image
Stretch image to fit SOLIDWORKS window

[ Keep background

Environment L

%| C\Program Files\SOLIDWORKS Corp\SOLIDWORKS\da'|

Browse... ‘
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MODEL SETUP

Open the Rendering Window. You should be able to see the current view of the SOLIDWORKS model.

\/ Note: You can set a camerain SOLIDWORKS or use the orbit camera setting in the Rendering
Window. (More information related to this option later in the document)

Camera Setup in SOLIDWORKS
Right-click the Camera option and click Add Camera.

Window F;age Dialog

Assembly| Layout | Sketch | Evaluate|

CIEAEIG)
G

Scene, Lights, and Cameras @

r & Scene (Courtyard Background)
g Lights

k. Wi fB0 Add Camera

3 5na Expand ltem
Expand All

Customize Menu

Uncheck the Lock Camera position except when editing to enable camera motion. Then click on the
green arrow.

Window Dialog

Assembly| Layout | Sketch | Evaluate|

S E B o S

T80 Camerad @
W X

Camera Type L
@Aimed at target

D Floating

|:| Show numeric controls

Lock camera position except when
Editing

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



MODEL SETUP

The output in the Render Window should be the same view as the SOLIDWORKS view of the model.

%
DS SOLIDWORKS
©
Postiffects Decals  Settings

Assembly | Layout | Sketch | Evaluste | SOLIDWORKS Add-|
< Tone Mapping

Type

= Gamma Correction

| Displey Gamma

| ¥ Output Leveis

[RISLtit Model | Motion Study |
SOLIDWORKS Premium 2017154 Edtion Fully Defined _Editing Assembly MMGS -

As the view changes in SOLIDWORKS, Radeon ProRender will continuously update the image in the
Render Window.

\/ Note: Every time the camera view is changed, Radeon ProRender restarts the render. The
iteration count resets and the image appears to be coarser.

\ 5 SOLIDWORKS
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CAMERA VIEW

Camera View Setup

By default, the view of the model in the Radeon ProRender window is the same as the view in the
currently active window in SOLIDWORKS.

Orbit Camera Setting

The Orbit Camera checkbox in Radeon ProRender enables you to override the camera view in the active
SOLIDWORKS window and change it independently without affecting the SOLIDWORKS view. Once the
checkbox is checked, the camera controls in Radeon ProRender are the same as the default ones in
SOLIDWORKS.

Note: When Orbit Camera is enabled, and the camera is moved interactively, the render
resolution is reduced to provide greater interactivity. Once interaction stops the render
resolution and quality return to the selected settings.

[ C:\Users\Annie\Desktop\ Camera Model\Camera For Demo\DSLR-350-SolidWorks2005.SLDASM” - Radeon ProRender

‘D’SSOLIDWORKS File Edit View Inset Tools Window Hep X | ) -[H-E-& -9 - N .‘ 8 b2 -0 X
- (0]

Rendering Properties About
Window  Page Dialog

File Window Help

PostEffects Decals  Settings

Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Radeon ProRender |
T Tone Mapping

Enabled

orrection

¥ Output Levels

A

[

W] Model [ Motion Study1 |
ISOLIDWORKS Premium 2017 x64 Edition Fully Defined _ Editing Assembly MMGS -~ [
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CAMERA VIEW

Camera Controls

Zoom
Middle Scroll Wheel Scroll

Camera view moves closer or farther.

Pan
Ctrl + Middle Scroll Wheel Click + Drag

Camera view stays in place, and the model moves in Xand Y relative to the render image.

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



CAMERA VIEW

Dolly
Shift + Middle Scroll Wheel Click + Drag

Background remains in place, while camera view moves closer or farther.

Focal Length Change
Alt + Middle Scroll Wheel Click + Drag

Model remains in place, while the focal length of the camera changes.

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



Image Output Settings

IMAGE OUTPUT SETTINGS | 20

These settings are set in the Properties Page and are only reflected in the Rendering Window. It will not

affect the actual model in SOLIDWORKS.

C\/ Tip: Remember to hit the green check mark or the settings will not update in Rendering Window!

Resolution Settings

In the Properties page, the output resolution and image size can be set. This will not change the model
resolution in SOLIDWORKS but only in the Rendering Window. There are pre-set resolutions as well as

standard sizes.

\/ Tip: Increasing the resolution can dramatically increase both the frame render time and also the
amount of graphics card memory required.

@ BB ¢ &

Radeon ProRender Properties @

W X

Resolution Settings ~

COutput Image Size:

192041080 [16:9) w
Width:
1920 =
llﬂiIIIIIIIIIIIIIIIIIIIII[‘llll,I
Height:
1080 2
llﬂlIIIIIIIIIIIIIIIIIIIIIullll,I

Fixed aspect ratio

9 | E

B

$

e

Radeon ProRender Properties

W X

Resolution Settings

Cutput Image Size:

1920%1080 (16:9)
6404360 (16:9

6400480 (4
T20x540 (4
300x600 [4:

3
3
3

1024x768  (4:3)
1280x720 (16:9)

1280m1024
192001080
192001200
2048x1152
2048x1536
25601440
25601600
Fe40m2 160
384002400
51202880

5120x 3200

(5:4)
(16:9)
(8:5)
(16:9)
4:3)
(16:9)
(8:5)
(16:9)
(8:5)
(16:9)
(8:5)

3

[ ] Allow uncertified devices

©)
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Render Settings
Choose the device for rendering (supports GPU and CPU).

@ Tip: Active real-time rendering using GPU is faster than CPU.

Render Settings L

Device:

All GPUs [uncertified) w

[] Allows uncertified devices

|:| Enable Texture Comprassion

Quality Settings

The quality settings for rendering can be adjusted depending on the quality of the rendered image, the
time and the complexity of the model.

\/ Tip: You can tune Radeon ProRender to be faster or slower by using a coarser model (i.e. low
mesh quality) for real-time rendering. For a complicated model, it is recommended to start using
lower quality settings until it is time to do a final render.

Quality Settings ~

Mesh Quality:

Use SOLIDWORKS Setting b

Render Quality:

Lowr w
AL Samples:

1 :
T TR ERREEETT T T 1]

Max Ray Bounces:

8 =
TN NN ENNRNNEErT T ]
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Mesh Quality

Mesh quality determines how SOLIDWORKS breaks the surface of models into triangles. When using a
lower setting, the meshes are more complex and require more processing power as well as memory. As
seen below, the curved surface in SOLIDWORKS renders into a model with more flat edges. At a high
level, the rendered image appears to a continuous surface.

Render Quality

Render quality depends on AA Samples and May Ray Bounces. AA Samples controls how many “shots”
that Radeon ProRender takes at the scene before updating the image and Max Ray Bounces changes the
number of times that a ray bounces off a surface to capture reflections.

Notice the image quality of the model when using number of ray bounces of 1 (left) and of 5 (middle) and
of 20 (right). The transparency and colour of the model is improved with more ray bounces. In the left
most photo, the inside of the model is black, since the surrounding light is unable to reach the inner
surfaces due to alow ray bounce setting.

\/ Tip: When using glass or other translucent appearances, use a high number of Ray Bounces to
fully capture all reflections (generally, a good number is 6 unless there are complex, translucent
parts).

Improved image quality comes at a cost to other factors. The right render took more time than the left

render to produce qualitatively, the same image quality.
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\/ Tip: Consider using lower settings for preliminary renders (i.e. lower mesh and render quality)
and changing to higher quality settings when you are near completion of design to ensure
surface quality and colour.

Floor Settings

The floor settings control the reflection of the model and its shadow on the floor.

Floor Settings ~
Shadow Intensity

E;illllllIIIIIIIIIIIIIIII‘...%

Reflection Intensity

0.5
W T T T

b=

Roughness

EI-'"""""'|||||||||||llll%

Shadow Intensity
Shadow intensity controls the transparency of the shadow. Left (0.1) Right (1)
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Reflection Intensity

Reflection intensity controls the transparency of the reflection. Left (0.1) Right (1)

Roughness
Reflections and shadows appear to be diffuse. Left (0.01) Right (0)

\/ Tip: For more realistic shadows on rougher surfaces, increase roughness for more diffuse
reflections.
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Debug

The Debug feature should only be used with AMD support ifissues are present. This includes a trace
ability to capture the interactions for Radeon ProRender. These interactions are generated within a set
of files showing the applied effects and the cause of error or bug.

Debug ~
[] Detailed Logging
[] Generate Trace

Trace Cutput Folder:

| ChlUsershAnniet\AppData\Local\Tem;

Browse...

Troubleshooting

Clear Shader Cache
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Post Effects Tab

These effects are applied to the rendered image after rendering is done in the Rendering Window. These
settings apply to the entire scene, including the model and its interactions with the light from the
background.

(\/ Tip: Adjusting post effects can tweak the scene without having to restart the rendering.

Tone Mapping

Tone mapping allows you to change the brightness of the scene to display more information or balance
details.

Simple
This is a simple exposure tweak and contrast option. You can brighten or darken the image by controlling
the exposure, or having brighter or darker contrast.

<« Tone Mapping

Type

Simple

Exposure

Contrast

Non-linear (Reinhard)

Prescale controls the brightness of darker areas (shadows), post scale controls the brightness of the
scene and burn controls the brightness of highlights and lighter areas.

%« Tone Mapping
Type
Mon-linear (Reinhard)
Prescale
0.10

Postscale
1.00

Burn

10.00
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Photolinear

Sensitivity is often related to the ISO setting and controls the camera’s sensitivity to light, exposure is
related to camera shutter speed which controls the time that the shutter is open to the exposed light
and F-stop is related to the aperture that is related to how much light is exposed to the “film".

Post Effects Decals Settings

<« Tone Mapping
Type

Photolinear

Sensitivity
20.00

Exposure

F-stop

White Balance

Check the checkbox to enable or disable.
This will tone the temperature of the scene to look warmer or cooler (i.e. more red or more blue).
Color Space: Adobe RGB, DCI-P3, Rec.2020, sRGB

<« White Balance
¥ Enabled

Color Temperature
6500.0

Color Space

sRGB

Gamma Correction

<« Gamma Correction

Display Gamma
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@ Tip: If the image is too dark, the first thing to adjust is the Gamma Correction.

On the left, the rendered image is very dark. Increasing the Display Gamma brightens the scene and
details are more visible. Left (1.00) Right (1.75)

Output Levels
Output levels controls the amount of colour that is shown.
Black and White

<« Qutput Levels

Black and White

Black Level

White Level

100.00

RGB

« ' Output Levels

RGE

Red Level
100.00

100.00

Blue Level
100.00
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Decals Tab

C\/ Note: Changing the decal will also restart the render! Best to use low quality settings.

Go to the Decals tab and press New... to start applyinga new decal.

EJ C:\Users\Annie\Desktop\Models\Block.SLDPRT* - Radeon ProRender = O X

File | Window | Help

V' Orbit Camera
Iterations: 624

L8

Post Effects Decals

New...
Color

Mask

Use Mask Alpha Invert Mask

Mirror X Mirror Y Repeat

Cnan Ta Avic

\/ Note: Decal masks enables the background of the decal to be transparent. The image maskis a
black and white image. Items in white remain in the decal whereas the black is removed.

AMD Y
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the file for the mask. For this purpose, the color and the mask will be the same file.

Post Effects Decals Settings

amd_decal

Mew... Edit... Delete

Color amd_decal.jpg

Mask

Use Mask Alpha Invert Mask

AMDC1

Mirror X Mirror Y Repeat

Post Effects Decals Settings

amd_decal

MNew... Edit... Delete
Color amd_decaljpg

Mask amd_decaljpg
Use Mask Alpha Invert Mask

AMD

Mirror X Mirror Y Repeat

After importing the decal, you can see the name and it acts as the color file. Click on ... button to select

ign Camera Align Camera

EJ Edit Decals — x

AMD_BLOCK _DECAL

Name AMD_BLOCK DECAL

Applying Decals

Decals are applied to the body, or a face on the body. Under Objects, either toggle bodies or faces.

\/ Tip: Afterimporting the decal from New..., you can directly click on the surface you wish to apply
the decal to — even without selecting a mask.
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Bodies
Toggle the Bodies button, and click on the surface to apply the decal (the star). The decal’s center will be
placed there.

Mirror X Mirror Y Repeat

= Objects

Select Bodies Faces

Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

|

Click on the surface you want to apply the decal. The body will be listed on the right.

Mirror X Mirror Y Repeat

Align Camera
“« Objects
Select Bodies Faces

Block_Body

“ Projection Mapping

Select Position Snap To Axis

Offset X (mm)
Offset Y (mm)

Angle
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Applying the decal as a body will project through the entire body before it hits another surface. On the
backside of the block, the decal is apparent.

Mirror X Mirror Y Repeat

Align Camera
“« Objects
Select Bodies Faces

Block_Body

“  Projection Mapping

Select Position Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

To place the decal on a single face, there are two options:

1. Apply decal using the faces toggle
2. Change the depth of the decal (discussed later)

Faces

Toggle the Faces button and then click on the face to place the decal. After clicking on the face, the body
and the face are listed on the right.

Mirror X Mirror Y Repeat

Align Camera

“« Objects
Select Bodies Faces

Block_Body
Face 5

“ Projection Mapping

Select Position Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle
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\/ Note: When selecting solely a Face, the back of the block does not have the decal projecting
throughiit.

Mirror X Mirror Y Repeat

Align Camera
“ Objects
Select Bodies

Block_Body

Face 5

“  Projection Mapping

Select Position Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

Depth
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Projection Mapping

If you want to move the decal, toggle the Select Position button, and click to place the decal at another
position on the blocks face. The decal is moved towards the center of the block.

Mirror X Mirror Y Repeat
Align Camera

“« Objects
Select Bodies Faces

Block_Body

Face 5

“ Projection Mapping

Select Position Snap To Axis

Offset X (mm)
Offset Y (mm)

Angle

If the positioning still needs to be tweaked, first click on Align Camera to position yourself normal to the
decal.

T
Mirrnr V
Align Camera
“« Objects
Select Bodies = Faces

Block_Body

Face 5

“  Projection Mapping

Select Position Snap To Axis

Offset X (mm)
Offset Y (mm)

Angle
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On an angle, the decal looked aligned but from the normal view, the decal is not in the middle.

Mirror X Mirror Y Repeat

Align Camera
“ Objects
Select Bodies = Faces

Block_Body

Face 5

“ Projection Mapping

Select Position Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

Depth

Enable the Select Position toggle, and slightly adjust the Offset X and Offset Y (The Xand Y axis are

relative to the decal).

Mirror X Mirror Y Repeat

Align Camera
% Objects
Select Bodies | Faces

Block_Body

Face 5

“  Projection Mapping

Select Position Snap To Axis

Offset X (mm)
Offset Y (mm)
Angle

Depth
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Note: You can also change the angle of the decal, but the datum point will be where you first
‘ \/’ clicked to placed your decal—NOT at the new decal center after the Offset Xand Y.

You can move the decal only on the surface/face that you selected (i.e. Face 5). If you want to move it to
another face, first delete the selected face by clicking “-", then selecting the face that you want (i.e. Face
4).

Mirror X Mirror Y Repeat

Align Camera
« Objects
Select Bodies Faces

Block_Body
Face 4

“  Projection Mapping

Select Position Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

Depth
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Depth
Depth applies to decals applied to surfaces on the body, not a face. Depth refers to how far the decal is
projected throughout the entire body. Its scale is relative to the entire length of the body.

The decal also extends past its selected surface. Notice how it seems to drag onto the other side. Any
pixels that extend past the edge of the applied surface are projected on the side. Depthis at 100.

Select Bodies Faces

Block_Body

“ Projection Mapping

Select Position Snap To Axis

Offset X (mm)
Offset Y (mm)
Angle

Depth

Decreasing the depth will shorten the decal projection throughout the block. Depthis 28.7.

Select Bodies

Block_Body

“ Projection Mapping

Select Position Snap To Axis

Offset X (mm)
Offset Y (mm)
Angle

Depth
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\/ Tip: Decreasing the depth to O will create a very “thin” projection of the decal on the surface and
will not wrap the decal around the sides of the object. Similar to applying the decal to a Face
instead of the entire Body.

Mirror X Mirror Y Repeat

Align Camera

“« Objects

Select Bodies Faces

Block_Body

“ Projection Mapping

Select Position Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

Depth

Size

Radeon ProRender will automatically detect the units of your model, and use the same units to adjust the
size of the decal. When scale is set to 100, the decal displayed on the modelis true to size.

\/ Note: If you change the units in SOLIDWORKS, close and reload the Rendering Window.
Tip: Best to set the units in SOLIDWORKS first before doing any render editing.

« Size (mm)
Width
¥ Lock Ratio

Reset Ratio

Fit To Objects

100.0

Scaled Size: 40 x 154 mm
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(\/ Tip: This is useful for seeing whether a sticker of a certain size would fit onto the model.

Surface
+ Surface
Opacity
Reflectivity
Roughness
Emissive
Opacity

Opacity adjusts the transparency of the decal. Left (100) Right (30)
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Reflectivity

The decal can show reflections of the surrounding environment. Left (50) Right (100).

C\/ Note: If reflectivity is 100 percent, the decal is essentially a mirror.

Roughness
Roughness diffuses the reflection. Left (0) Right (20)

Radeon ProRender add-in for SOLIDWORKS User Guide ©2017 Advanced Micro Devices, Inc. Allrights reserved.



DECALS

Emissive

The decal applied acts as an emissive image (i.e. and LCD screen). In the image below, the model is lit
from inside by the decal.

\/ Note: This will decrease performance and it is a computationally heavy feature.

Iterations: 551

AMDa o V' Orbit Camera R A D E D N

Post Effects Decals Settings
Penguins 2.
New... Edit... Delete
Color C:\Users\Public\Pictures\Sarr ...

Mask

Use Mask Alpha Invert Mask

Mirror X Mirror Y Repeat

Align Camera
0.0

Depth

+ Size (mm)

Width
134.0 V' Lock Ratio

Height Reset Ratio

1005 Fit To Objects

Scale
100.0

Scaled Size: 134 x 100.5 mm

“ Surface

Opacity

Reflectivity

Roughness

Emissive
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Multiple Decals

To add multiple decals, click on New... and select another decal.

(\/ Tip: Remember to select color and mask!

The decal is applied to the same face with the first decal.

In Edit..., there are now two decals. You can also rename your decal if you wish.

EJ Edit Decals - e

RadeonPro BLOCK_DECAL
AMD_BLOCK_DECAL

Name RadeonPro_BLOCK_DECAL

\/ Note: In the list above, the RadeonPro decal will be laid on top of the AMD decal. To change the
ordering of the layer, pressthe A V.
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In the list below, the AMD decal will be on top of the RadeonPro decal.

EJ edit Decals - *

AMD_BLOCK_DECAL
RadeonPro_ BLOCK_DECAL

Name RadeonPro BLOCK DECAL

To adjust a particular decal, select the decal in the drop-down list at the top and adjust the settings for
that decal.

Post Effects Decals Settings

RadeonPro_BLOCK_DECAL

RadeonPro_BLOCK_DECAL
AMD_BLOCK _DECAL

C\/ Tip: Remember to toggle Select Position button to move the decal!

The same controls are used to move the different decals (i.e. the positioning, sizing and aligning of the
camera).
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Multiple Bodies

If your assembly has multiple bodies, you can apply the decal to multiple bodies and/or faces. Ensure the
Bodies toggle is enabled, then click on the surfaces while holding CTRL key. On the right, there should be
two bodies selected, and toggle the select position to drag the decal on the two bodies.

C\/ Tip: Place decals across the surfaces of bodies that are parallel for best results.

Align Camera

“ Objects

Select Bodies Faces

Block-1_Body
Block-2_Body

“ Projection Mapping

Select Position Snap To Axis

Offset X (inches)

Offset Y (inches)

Angle

You can even do the same with selecting the faces to prevent the decal from projecting through the
bodies.

Align Camera
“« Objects
Select Bodies Faces

Block-1_Body
Face 5
Block-2_Body

Face 5

“ Projection Mapping

Select Position Snap To Axis

Offset X (inches)

Offset Y (inches)

Angle
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The part of the decal on each body will “stick” to that surface. If the model is moved in SOLIDWORKS, it
will remain the same in Radeon ProRender.

\/ Note: You are still able to change the size, position, scale...etc. Radeon ProRender will keep the
decals onits respective surface.

In the image below, there is an offset in the Xand Y direction, as well as an increase in scale. Notice how
the decal still sticks to the two faces.
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Curved Surfaces

The decal is placed on the outer surface of the glass. Since the decal is applied as a projection, the decal
that is applied on the lower part of the glass is projected. The decal is applied on the entire body, not just
aface.

To fix the alignment on curved surfaces, enable the Snap To Axis checkmark.

Mirror X Mirror Y Repeat

Align Camera

“ Projection Mapping

Select Position V' Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

Depth

“ Size (mm)
Width
V' Lock Ratio

Height Reset Ratio

21.0 Fit To Objects
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If you want to prevent the decal from projecting through the glass, select the face by toggling the Face
button and clicking the surface to apply the decal.

Mirror X Mirror Y Repeat

Align Camera

%« Objects

Select Bodies Faces

Glass_Revolvel

Face 5

“ Projection Mapping

Select Position v Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

Depth

Then decrease the depth of the decal.

Mirror X Mirror Y Repeat

Align Camera

“« Objects
Select Bodies Faces

Glass_Revolvel

Face 5

“ Projection Mapping

Select Position v Snap To Axis

Offset X (mm)

Offset Y (mm)

Angle

Depth
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Decrease the depth until you can no longer see the decal extend to the other side, and only on the side

you want.

Mirror X Mirror Y Repeat

Align Camera

“ Objects
Select Bodies Faces

Glass_Revolvel

Face 5

“  Projection Mapping

Select Position V' Snap To Axis
Offset X (mm)
0.0
Offset Y (mm)

Angle

Depth

Final look at the decal on the curved surface.

i |
N
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v

J boxwillappear even if you did not change the model in SOLIDWORKS.

Note: When saving the file, the decal settings save within the SOLIDWORKS model! A pop-up

File Edt View Inset Tools Window Hep A | [ - - @S-

>
|| ZS SOLIDWORKS

= ] ©
Rendering Properties
Window  Page

|§~ac.‘.?v_nx|9

File Window Help

V' Orbit Camera

About 2 " ltcrations: 14663

Dialog

Blel®] >

@ Glass (Default<<Default> Display State 1>
v [ History

Sensors

Al Annotations

5 Masteril <ot specids

[] Front Plane

[] Top Plane
[ Right Plane
1. origin A 1
> & Revolvel
T () sketch2

SOLIDWORKS

Save modified documents

One or more documents being closed as a result of this
operation have been modified.

—> Saveall

All modified documents will be saved.

— Don'tSave

All changes to unsaved documents will be lost.

Cancel

<

| Model [ Motion Study1 |
SOLIDWORKS Premium 2017 x64 Edition

Editing Part

PostEffects  Decals  Settings

AMD Deeal

New.

Color sktop

Use Mask Alpha

Edit. Delete

\AMD Decaljpg ..
\AMD_Decaljpg .

Invert Mask

AMDA

Mirror X

= Qbjects

Mirror ¥

Repeat

‘Align Camera

Select 'Bodies  Faces | -

Glass_Revolvel

Face 5

= Projection Mapping

Select Position

Offset X (mm)

Offset Y (mm)

Angle

Depth

= Size (mm)

416
Height
160

Seale

Y Snap To Adis

' Lock Ratio.
Reset Ratio

Fit To Objects

1000

Scaled Size: 416 x 16 mm
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Settings Tab

Completion

Set when the rendering is completed by number of rendering iterations or time elapsed. If there are no
limits set for time or iterations the render will keep rendering until the user cancels the render or closes
the render window.

Post Effects Decals = Settings

Post Effects Decals = Settings

« Completion
. +« Completion
Post Effects Decals | Settings oz
Type
“« Completion w® Time
lterations

Type
7 0 10

Unlimited Hours  Minutes

If you set iteration/time constraint and the render has finished and you wish to go back to rendering, set
the Completion to Unlimited and press the Continue Button.

File Window Help

- — - e +" Orbit Camera
Ar Continue SEVE...
-— Iterations: 4582
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Lighting

C\/ Tip: Making any changes here will restart the iterations! It is best to set the lighting first.

Ambient Multiplier

By using an hdr file, the background contains enough information to display ambient lighting. The
Ambient Multiplier is adjusted to make the surrounding light brighter or dimmer. When the ambient light
multiplier is decreased, background details are more visible, but overall scene is darker.

Left (4.5) Right (0.5)

Emissive Multiplier

The Emissive Multiplier applies to objects have light emitting appearances (i.e. modelling a LED lamp).
When increasing the emissive multiplier, the ball in the middle (which has an emissive appearance applied
toit) seems to be brighter. Left (1.0) Right (5.0)
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Final Render

/ Tip: To balance the amount of details shown, different effects must be adjusted. There are
A J trade-offs to this, as changing the effects can show surface details, but make the overall scene
look very bright or dark.

After editing the scene, you can export the scene settings to apply to another model. Go to File > Export
Scene Settings. When opening the Rendering Window for another model, you canimport those setting
by going to File > Import Scene Settings.

E ChlsersvAnnietDesktopt Camera Model\Camera For DemcotD5LR-350-5alidW

File | Window Help

Import Scene Settings < Orbit Camera
| Export Scene Settings . - Iterations: 205

Export ProRender Scene

Exit

7 Tip: Remember to set Render Setting to high quality in the Properties Page when you are
N # nearing completion of the Render for optimal quality.

Click on Save... to export the current frame.

E ChUsersh\Annig\Desktop' Camera Model\Camera For Demo' D5SLR-350-5colidWorks:

File Window Help

¥ Orbit Camera
Iterations: 1328

Save the current render

L%
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ANIMATION

In SOLIDWORKS, click on the Animation Dialog. Select the motion study in SOLIDWORKS that you want
to animate and specify the number of frames to render per second.

7 . .
| | PS soLIDWORKs | File Edit

Wiew

Insert  Tools

Window Help | D'@"ﬁ'ﬁ'mﬂﬁm?v_mx

© | o

Rendering Properties | Animation | About
Window

Page Dialog Dialog

Assembly | Layout | Sketch | Evaluate | SOLIDWORKS Add-Ins | Radeon ProRender |

T T MR

& o

W
:| Motion Study Output
Motion Study 1 ojectyParts and Assemblies\Engine Assembly.avi
+" Use Full Timeline Keep Rendered Frames
Start (seconds) Frame Completion Iterations
End (seconds) lterations Per Frame 100
Frames Per Second
Cancel
st <] B > > W o s @ o as8 @ s
S 7 {E‘S 0 sec Ssec ‘ﬂ)sec ‘155&: ‘Zﬂlsec
) B & ¥ [ [ R [ B | [ [
&l - @ Engine Assembly (Default<Dis ’ #
@? Qrientation and Camera Vi '.
4 Lights, Cameras and Sceng|
=) RotaryMotorl .
4 % Engine Block=<1> [Default<| ’
4 % (-) engine cam shaft<1= ([ ’
4 ff'[j (-) engine cam shaft<2> ([ ’
v By (-) Crank Shaft<1> (Defaul ]
4 Pist:
R L N LLP
>
S Model | Motion Study 1 |
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For each frame that will be rendered, specify the number of iterations or the time for rendering
completion.

Output Output

oject\Parts and Assemblies\Engine Assembly.avi oject\Parts and Assemblies\Engine Assembly.avi

Keep Rendered Frames Keep Rendered Frames

Frame Completion Ilterations Frame Completion

lterations Per Frame 100 Time Per Frame 0 1

Hours  Minutes

\/ Tip: Remember that every frame is rendered — every single frame will need to have complete the
specified number of iterations/time. Which adds up in time!

Upon starting the render, the animation dialog will show the number of frames that need to be rendered,
the total estimated time, and the progress of the render.

Radeon ProRender will create a video of the current view of the model in SOLIDWORKS.

Motion Study

Use Full Timeline Keep Rendered Frames
Start (seconds) 0.0 Frame Completion
End (seconds) 5.0 teratio 'er Frame

Frames Per

Frame Preview Render Info
Rendered Frames: 1 /40
Estimated Time Left: & minutes

Frame Progress
]

Render Progress
LI
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Upon completion, Radeon ProRender will render the video in the folder that contains the model by
default.

{B| Radeon ProRender Animation — b4

Motion Study

Use Full Timeline

Render Info
Rendered Frames: 40 / 40

Render Complete

Open Folder

Screenshot of a single frame in the rendered video.
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